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1 Invoice Management Overview

The Invoicing tab is a centralized location to manage all types of invoices, such as purchase order
invoices, work order invoices, and non-purchase order invoices. Users are able to handle the workflow for
purchase orders using invoice settings. Also, the layout for the Invoice Entry page can be managed under

the Invoicing tab using the Invoice Mask link.

1.1 Flexible Invoice Layouts

The invoice entry, approval, and view pages can be configure so that the invoice header and the detail

information are displayed in separate tabs (default configuration) or together.

When the header and detail information are displayed together, this functionality is controlled by their
respective invoice settings for the system. The only flexibility allowed by invoice masks is the percentage
dedicated to the header section and the detail section. This information is entered in the Options page for
the specific mask in the Header Height and Detail Height fields. The combined percentages must equal
100.

To configure the invoice pages to display the invoice header and detail information together, the

following invoice settings need to be enabled with the following information in the Path field:
Invoice Entry from Manage Purchase Order Administration Page

» Invoice Setting: Invoice Entry Module Path
» Path field: ../../swfs/UIE/modules/MinvoiceEntry WithDtls.swf

Invoice Entry from Invoice Entry Tab

» Invoice Setting: Invoice Manager Entry Module Path
» Path field: ../../swfs/InvoiceManager/modules/MinvoiceEntry WithDtls.swf

Approve Invoice

» Invoice Setting: Invoice Approval Module Path
* Path field: ../../swfs/UIE/modules/MinvoiceView WithDtls.swf

View Invoice from Manage Purchase Order Administration Page

* Invoice Setting: Invoice View Module Path

e Path field: ../../swfs/ViewInvoice/modules/Minvoice View WithDtls.swf
View Invoice with Invoice Manager

» Invoice Setting: Invoice Manager View Module Path
e Path field: ../../swfs/ViewInvoice/modules/Minvoice View WithDtls.swf

For more information on how to add or edit an invoice setting, see Invoice Setting Addition and Editing.
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1.2 Invoice Task Center Layout Options

The Invoice Task Center can be displayed horizontally or vertically. The horizontal display is the default.
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Figure 1: Invoice Task Center - Horizontal display (default)
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Figure 2: Invoice Task Center - Vertical Display

To configure the vertical display, the following two invoice settings need to be enabled with the following

information in the Path field:

Invoice Setting Path Field

Task Center Flow Module Path

../../swfs/InvoiceManager/modules/
MinvoiceVTaskFlow.swf

Task Center List Module Path

../../swfs/InvoiceManager/modules/
MinvoiceVTaskList.swf

For more information on how to add or edit an invoice setting, see Invoice Setting Addition and Editing.
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2 Invoice Mask

An invoice mask determines the behavior of the entry/approval process and the layout of the entry page.
Invoice masks can be configured to meet the needs of your organization. Contact your Basware

Implementation Team or Client Care Team if you need assistance configuring invoice masks.
Invoice masks are specific to:

e PO Invoices
WO Invoices
e Non-PO Invoices

» Invoice processing step - Pre-Process, Post-Reconciliation, Post-Approval, etc.
Vendors can be customized to use specific masks or a global mask can be used for all vendors.
The following permission is required to manage invoice masks:

* 3510 - Can Manage Invoice Masks

Invoice Mask List

Filter| Show All [keywords Submit

>

* purchase Order, standard Purchase order Mask,

*work order, Standard Work Order mask,

* Non-Po, Standard Non-PO Mask,

* Portal Purchase Order, Standard Portal Purchase order Mask,
* portal work Order, Standard Portal Work order Mask,

* portal Non-PO, Standard Portal Non-PO Mask,
* Pre-Process Purchase order, Standard Pre-Process Purchase order mask,

* Pre-Process Work Order, Standard Pre Process Work Order mask,
* Pre-Process Non-PQ, Standard Pre-Process Non-PO Mask,

* portal Pre-Process Purchase Order, Standard Portal Pre-Process Purchase O...
* Portal Pre-Process Work Order, Standard Portal Pre Process Work Order Mas...

* portal Pre-Process Non-PO, Standard Portal Pre-Process Non-PO Mask,
Purchase oOrder, PAVELS Standard Purchase Order Mask,

Purchase Order, KIPS Standard Purchase Order Mask,
Pre-Process Purchase order, KIPS Standard Pre-Process Purchase Order Mask,...

Purchase oOrder, Aparna Standard Purchase order Mask,

Non-PO, Aparna Standard Non-PO Mask,

Pre-Process Purchase Order, Copy Standard Pre-Process Purchase Order Mask,...
Non-PO, header Standard Non-PO Mask,

Pre-Process Non-PO, Detail Standard Pre-Process Non-PO Mask,

Pre-Process Non-PO, PAVELS Pre-Process Non-PO Mask,

showing 36 item(s)

Figure 3: Invoice Mask List page

Table 1: Invoice Mask List page action definitions

Action Name Definition

Options Allows the user to customize various aspects of the
invoice entry page. The default masks, marked
with an asterisk (*) cannot be edited.
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Table 1: Invoice Mask List page action definitions (continued)

Action Name Definition

Details Allows the user to customize the field labels, field
types, tab order, sort order, default values for
fields, etc. on the Invoice Entry page. The default
masks, marked with an asterisk (¥) cannot be
edited.

Basware P2P 18.2

Copy Allows the user to copy an existing invoice mask.

Delete

Allows the user to delete an existing invoice mask.
The default masks, marked with an asterisk (*)
cannot be deleted.

Mark Global Allows the user to select one mask to be used for

all vendors.

Export Allows the user to export a mask to another user.

Allows the user to import a mask from another
user.

Import

Allows the user to update an existing mask with
the latest changes after an upgrade.

Sync

ﬂ The default masks that are shipped with the system are not editable.

2.1 Invoice Mask Options Configuration

Invoice Mask - Aparna Standard Purchase Order Mask

Mask Name *

Display Invoice after posting
Require Distribution

Require Distribution on Approval
Default Distribution

Invoice By Receipts

Allow Free Form

Auto Select PO Receipts

Auto Select PO Lines

Enable Short Pay

Enable Short Receive

Enable Invoice Edit During

Image Attachment Required

Header Height (Percentage [0-100])*
Detail Height (Percentage [0-100])*
Image Height (Percentage [0-100])*
Image Width (Percentage [0-100])*

Mask ID

Aparna Standard Purchase Order Mask
O Yes ® No
O Yes ® No
O Yes @ No
© None @ Detail (O External
O Yes @ No
@ Yes O No
@ Yes O No
O Yes ® No
O Yes ® No
O Yes ® No

© None O Post Process (O Approval O Post Approval
O Approval & Post Approval @ All

O Yes ® No

=

Figure 4: Invoice Mask Options page for PO Invoice
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Table 2: Edit Invoice Mask Options page field definitions

Field Name Mask Type Definition

Mask Name PO, Non-PO Allows the user to enter a
name for the mask.

Display Invoice after PO, Non-PO When set to Yes, the

Posting invoice displayed after

processing. If set to No, the
processed invoice is not

displayed.
When set to Yes,
the invoice is
only displayed

when invoice
entry originates
from the Invoice
Manager. When
aPOis
reconciled from
the Manage
Purchase Order
page, the invoice
is not displayed
after processing
and the user is
returned to the
Manage
Purchase Order

page.

Display Distribution PO, Non-PO When set to Yes, a field is
displayed on the invoice to
enter account code
distribution. This is usually
a default setting for non-PO
invoices.

Require Distribution PO, Non-PO When set to Yes, the user is
required to enter account
code distribution for
purchase order invoices.
When set to No, the user is
not required to enter
account code distribution
purchase order invoices.

Require Distribution on PO, Non-PO When set to Yes, the
Approval approver must enter the
account code distribution
when approving purchase
order invoices. The invoice
entry user does not enter
distribution.
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Table 2: Edit Invoice Mask Options page field definitions (continued)

Field Name Mask Type Definition

Default Distribution PO, Non-PO Determines where the
distribution is to occur.
Select none if distribution is
not being used for purchase
order invoices. Select detail
if the distribution is to occur
at the line level. Select
external if the distribution is
coming from an external
accounting system
(Excalibur or BOLO).

Invoice by Receipts PO, When set to Yes, the
invoice displays the
received lines.

Display Details Non-PO When set to Yes, the grid
for lines is displayed.

Require Details Non-PO When set to Yes, users are
required to enter line items.

Allow Free Form PO, Non-PO When set to Yes, free form

line items can be added to
the invoice. This function
mostly relates to PO
invoices and is useful if
there are receiving charges
on invoices that are not on
the related PO. When set to
No, free form line items
cannot be added to the
invoice.

Auto Select PO Receipts PO, When set to Yes, the
received line items are
automatically populated on
the invoice detail if there
are open receipts against the
PO.

Auto Select PO Lines PO, When set to Yes, all PO
lines on the invoice are
automatically populated if
there is no open receipt.

Enable Short Pay PO, Non-PO When set to Yes, invoices in
financial discrepancy and/or
invoice approval can be

short paid with a valid
reason.
The Short Pay
Reason field
needs to be

configured for
the Invoice
Approval
Header Display.
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Table 2: Edit Invoice Mask Options page field definitions (continued)

Field Name Mask Type Definition

Enable Short Receive PO, When set to Yes, invoices in
receiving discrepancy can
be short received.

The Short
Receive Reason
field needs to be
configured for
the Invoice
Approval
Header Display.

Enable Invoice Edit During | PO, Non-PO Determines whether
purchase order invoices can
be edited after the pre-
process work queue. Select
none if purchase order
invoices cannot be edited
after the pre-process work
queue. Select post process,
approval, post approval, or
approval and post approval
if purchase order invoices
can be edited in one of these
work queues. Select all if
purchase order invoices can
be edited in all the work
queues listed above.

Image Attachment Required | PO, Non-PO Determines whether image
attachments are required for
purchase order invoices.
Select Yes if image
attachments are required.
Select No if image
attachments are not
required. The default value
is No.

This feature is
available for the
invoice entry
mask and/or the
pre-process
invoice mask.
Based on how
the masks are
configured
determines when
the image is
required.

Header Height PO, Non-PO When a split page is used,
this determines the
percentage of the page
dedicated to the header.
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Table 2: Edit Invoice Mask Options page field definitions (continued)

Field Name Mask Type Definition

Detail Height PO, Non-PO When a split page is used,
this determines the
percentage of the page
dedicated to the detail
section.

Image Height PO, Non-PO When viewing images, this
determines the height of the
image in relationship to the
page.

Image Width PO, Non-PO When viewing images, this
determines the width of the
image in relationship to the
page.

Mask ID PO, Non-PO An auto-generated number
assigned by the system.

ﬂ » For invoice image attachments, only PDF format is supported by Invoice Manager.
Other formats can be used, but the client is responsible for troubleshooting issues
with formats other than PDF. For more information, please refer to Invoice Manager
User Guide - Chapter 7.
» System setting /091 — Absolute Path to Attached Document Directory must have a
valid URL when using invoice attachments.

2.2 Invoice Mask Details Configuration Steps

Once the mask options are configured, the next step is to adjust the details. To do this, select the mask and
click Details. Masks are defined by Mask Screen Type and Mask Field Type.

Mask Screen Types Available:

* Invoice Approval
* Invoice Entry

*  View Invoice
Mask Field Types Available:
» Invoice Approval

» Invoice Approval Routes Display
* Invoice Header Display

» Invoice Line Detail Display

* Invoice Payments Display

* Invoice Recurring Display

» Invoice Recurring Parent Display

* Invoice Work Queue Display
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» Invoice Entry (Detail or Advanced)

* Invoice Detail Attribute
* Invoice Distribution

* Invoice Edit Details

* Invoice Header

» Invoice Header Attribute
» Invoice Line Detail

* Invoice Vendor

e View Invoice

» Invoice Approval Routes Display

» Invoice External Distribution Display
» Invoice Header Display

» Invoice Line Detail Display

» Invoice Payments Display

* Invoice Recurring Display

» Invoice Recurring Parent Display

* Invoice Work Queue Display
Step 3

Once the screen and field type is selected, the fields to edit are displayed. The fields vary depending on
the mask type. In this example, the Invoice Entry - Invoice Edit Details fields are displayed.

Fields - Aparna Standard Purchase Order Mask - Step 3 112 0f 12 tems processed
Field Name = Field Label Default Value = Default Scripts. Field Typen Widths Maxm Requireds Editables Disables Span: Align Tabu Orders
ItemCategory_ID Item Category : 0 SelectBox  |v o 30 [m] = o [u] left v 3 3
ItemName Item Name : Text Box j 200 100 [m} %] [m} a left j 2 2
ItemPrice Invoice Unit Cost : 0.00 Text Box j 200 20 o o o left j 70 70
itematy ttem Qty: 0 TextBox v 200 2 o a o o left ~ 0 P
ItemSKU Item SKU : Text Box. j 200 50 [m} %] [m} a left j 1 1
LineAccCode Line Account Code : Text Box v 200 100 o %} %) o left v 3223 3223
LineUsritem1 Line Udef1: TextBox  |v| 200 50 o =] m] left K 0 o
LineUsritem2 Line Udef2: Text Box. j 200 50 o %} %) o left j o o
LineUsritem3 Line Udef 3 : Text Box i 200 50 o %} ) o left v o ]
LineUsritems Line Udef 4 TextBox  |v| 200 50 o @ @ o left K 0 o
LineUsritems Line Udef s : Text Box j 200 50 o %) [m} left ? o o
unit Unit: EACH SelectBox v o o o @ o o left v s s

Figure 5: Invoice Mask - Details example, Step 3

Table 3: Edit Invoice Mask Details Page Column Definitions

Column Name Definition

Field Label The name of the field displayed on the Invoice
entry page.

Default Value The static value defaulted on the page for the
specific field.
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Table 3: Edit Invoice Mask Details Page Column Definitions (continued)

Column Name Definition

Default Script The dynamic default value from the following
tables:

* Purchase Orders (for PO Masks)
*  Vendors (for Vendor Masks)
*  Work Orders (for WO Masks)

Field Type This identifies the entry type for the field. The
field types available are check box, currency, date,
display, list, lookup, numeric, radio button, select
box, text area, textbox, and TLA. Some field types
such as list boxes or drop-down boxes require
extended mask parameters.

Width The width of text fields.

Max The maximum number of characters in the text
field.

Required Select if the field is required.

Editable Select if the information in the field is editable.

Disable Select if the field should be disabled.

Span Select if the information needs to be displayed in

more than one column.

Align Select if the information is to be displayed left-
aligned, right-aligned, or centered.

Tab Set up the tabbing sequence for the cursor.

Basware recommends entering in increments of 10
— starting with 10. Using this convention allows
you the flexibility to move/reorder a field between
two other fields without having to renumber
everything.

Order The field Display order. Odd numbers display on
left (header) and even numbers on right (header).

Basware also recommends using the same numbers
for the Tab and Order fields. Using this convention
keeps the mask organized.

ﬂ For invoice entry masks, the cursor defaults to the field with the lowest tab sequence. This is

usually the first data entry field on the invoice. The default cursor affects the following pages:

* Invoice Entry from the Reconcile Purchase Order page

* Invoice Entry from the Vendor Portal

* Entering a new invoice from the Manage Invoice page

* Viewing an invoice in the Inbound Work Queue from the Manage Invoice page

* Viewing an invoice in the Pre-Process Work Queue from the Manage Invoice page
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ﬂ For non-PO e-invoices, the non-PO invoice mask has to be configured to have a location ID set
up in the Default Value column for the Location ID field. If there is not a location ID in the
Default Value column for the Location ID field, the non-PO e-invoice has a location ID of 0.

This means that the non-PO invoice cannot be viewed or sent for approval.

Step 4

The Field Mask/Message page is displayed. Here is where field mask information, error messages, and

help messages are entered.

Field Mask/Message - Aparna Standard Non-PO Mask - Step 4 -4 0f 4 tems processed
Field Name Field Type Field Mask Error Message Help Message
ItemName Text Box
ItemPrice Text Box
Itematy Text Box

ItemsKu Text Box

Figure 6: Invoice Mask - Edit Field Mask/Message example, step 4

Table 4: Field Mask/Message page column definitions

Column Name Definition

Field Name The name if the field entered in step 3.
Field Type The type of field, as selected in step 3.
Field mask The way the information is displayed for the field.

For example, the way dates are displayed come
from this setting. Enter 99/99/9999 to require two
digits for the month and four digits for the year.
Characters can be configured from this mask as
well.

Error Message The message displayed for the selected field when
information is entered incorrectly or not entered.

Help Message The message displayed to inform the user of what
type of information is needed for the selected field.

Step 5

The Query/Lookup page is displayed for select boxes (step 5) and check boxes (step 6).

Query/Lookup - Aparna Standard Non-PO Mask - Step 5 30 3 items processed
Field Name Field Type Error Message Help Message Query Name Query saL Query Display Query Value Lookup Name
ItemCategory_ID Select Box aryGetCategories CategoryName ItemCategory_ID
ttematy Select Box

Unit Select Box SELECT Unit FROM Units unit Unit

Figure 7: Invoice Mask - Query/Lookup page example, step 5 & 6
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ﬂ Columns may vary depending on the field type being configured.

Table 5: Select Box Query/Lookup Page Column Definitions

Column Name Definition

Field Name The name of the field entered in step 3.

Field Type The type of field selected in step 3.

Error Message The message displayed for the selected field when
information is entered incorrectly or not entered.

Help Message The message displayed to inform the user of what
type of information is needed for the selected field.

Query Name The name of query file. This must be in the
common\manage folder.

Query SQL The SQL for the query. Use this in lieu of the
Query Name field.

Query Display The value that is displayed to the user. This is case

sensitive. This information must match the
information in the Query Value field.

Query Value The value stored in the field. This information
must match the information in the Query Display
field.

Lookup Name The look up name is configured in this field from
the list of look ups established in Look Ups from
the Admin tab.

Radio/Check Display The value that is displayed to the user.

Radio/Check Value The value stored in the field.

2.3 Invoice Mask Details Configuration - Advanced

Some mask field types, such as on the Invoice Entry screen types, allow for Advanced Editing.

Field Type - Aparna Standard Non-PO Mask - Step 2

Mask Field Type * Invoice Header

SelectType* @ nmiq O Advanced ’

Each field allows the user to write a customized action script. For more information or assistance, contact

your Implementation or Client Care team.
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Invoice Advanced Mask Details - Aparna Standard Non-PO Mask 40 of 40 items processed
Field Name u On Focus On Blure On Changen On Click On Key Downs On Key Up On Mouse Downs On Mouse Ups On Validaten
DiscountAmt
DueDate
Exception_ID
ExceptionName
Freight

FreightAccount
FVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVV VN

Figure 8: Invoice Advanced Mask Details
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3 Invoice Settings

Invoice Settings define the parameters that drive the behavior of the workflow process such as

discrepancy, verification, etc.

Also, users can set up account global discrepancy parameters to trigger Financial Discrepancy or make

Tax and/or Freight fields required during Invoice Entry.

The following permission is required to be able to access this functionality:

» 138 — Manage Invoice Settings

Invoice Setting List

Filter| Show All |~ |-and -| All [keywords

* Flag discrepancy on line ftem unit cost, All,

Max. Percentage to flag discrepancies, All,

Max. Amount to flag discrepancies, All,

Enforce 3-way match, All,

Default item Category for Off catalog Items, Item Category,
Map process to show for Involce Map, Al

stop Reconclliation of fully reconciled Purchase orders, All,
Check Recursive WQ for specified Work Queues, All,

* Image reference URL, All,

Invoice POP3 Server, All,

Invoice POP3 Server Password, All,

Invoice POP3 Server Port, All,

Invoice POP3 Server User Name, All,

Enable Tlagging of Discrepant purchase orders, All,

Max Wait Days for Recelving Discrepancy, All,

Check Budget Avallability for Non-PO Invoice, All,

Task Center Flow Module path, All,

Task Center List Module Path, All,

Showing 19 item(s)

Compare entered Invoice Total and Calculated PO Total for PO Discrepancy, ...

View Settings All

Edi

Disable

Delete

Figure 9: Manage Invoice Settings page

Action Name Definition

Add Allows the user to add a new setting.

Edit Allows the user to edit an existing setting.

Enable Allows the user to enable a setting that has been
disabled.

Disable Allows the user to disable a setting that is enabled.

Delete Allows the user to delete an existing setting.

3.1 View Settings

The view settings feature allows the user to view the settings in one table. To view the settings, select one

of the following from the Drop-down field: All, General, PO Reconciliation, PO Discrepancy, Invoicing,

and Layout. Click Retrieve.

© Copyright 1999-2018 Basware Corporation. All rights reserved..
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Figure 10: View Settings page 1

Invoice Settings 13 0f 13 items processed
Setting Default Upper Value Lower Value Enabled
Check Budget Availability for Non-PO Invoice No Yes Yes
Check Recursive W for specified Work Queues 2 Yes
Enable exact match receiving for E-Invoice No
Generate System Invoice Image No

https:/ [qativerian.com
Image reference URL Ipitdocs/qapd/ta 3
Ico/01pdf
Image URL for external reference
Map process to show for Invoice Map 12340567 1234567 Yes
Max Wait Days for e-invoice 60
"Max Wait Days for Receiving Discrepancy o 5 Yes
Max Wait Days in Workflow o
Non-PO Invoice Import Specification o
Purchase Order Invoice Import Specification o
Work Order Invoice Import Specification 0

Figure 11: View Settings page 2

Column Name Definition

Setting Displays the name of the setting.

Default Displays the default value for the setting.
Upper Value Displays the upper value for the setting.
Lower Value Displays the lower value for the setting.
Enabled Displays whether the setting is enabled or not.

Invoice Settings are classified into the following groups: general, PO reconciliation, PO discrepancy, WO

reconciliation, WO discrepancy, and layout.

3.1.1 General Invoice Settings

Calculate Tax on auto-reconciliation of a shipment

» This setting determines whether tax is calculated when a shipment is auto-reconciled.
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Check Budget Availability for Non-PO Invoice

» This setting determines whether budget availability is checked when processing a non-PO

invoice.
Check Recursive Work Queue for Specified Work Queue
» This setting determines whether work queues can be checked recursively.
Enable Exact Match Receiving for e-Invoice

» This setting determines whether the receipt of the goods and the e-Invoice must match to be

reconciled.
Image Reference URL

» This setting allows the user to set up a URL for images used for batch invoices. The following

configuration must be used:
http://<server>/pitdocs/<instance>/t<tenant-id>/cO[ ].pdf

A .zip file containing images and an XML descriptor must be placed in the Basware File Manager in the
t<tenant-id>/c0/zip directory. When the ProcessInboundInvoice template is run, it unzips the

invoice images in this zip file to the t<tenant-id>/c0/XMLImage/image/<MMDDYYYY> folder.

These invoice images appear in the In Entry work queue or can be accessed from the Batches tab in the
Invoice Manager. When a batch invoice is matched to a vendor or purchased order, the invoice image is
copied to the t<tenant-id>/c0/invoice/Batch/<MMDDYYYY> folder in the Basware File

Manager.

ﬂ For invoice image attachments, only PDF format is supported by Basware P2P Invoice
Manager. Other formats can be used, but the client is responsible for troubleshooting issues
with formats other than PDF. For more information, refer to the Invoice Manager — User Guide
— Chapter 7.

Image URL for External Reference

» This setting allows the system to retrieve images that are stored in an external system.
Map process to Show for Invoice Map

» This setting allows for the display of where invoices are in the invoice process.
Max Wait Days for e-invoice

» This setting determines the maximum number of days an e-invoice can stay in the inbound
work queue without any action taken against it. When the maximum number of calendar days
is reached, the invoice is automatically canceled and an e-mail is sent to the e-invoice manager

(users with permission 3515 — Manage e-invoice). This is based on the invoice creation date.

Max Wait Days for Receiving Discrepancy
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» This setting determines the number of days an invoice that is between being processed and

being sent to receiving discrepancy waits before it is actually sent to the receiving discrepancy
work queue. Once the invoice has exceeded the determined number of wait days, it is sent to
receiving discrepancy. If the discrepancy no longer exists, the invoice is sent to the appropriate

work queue.
Max Wait Days in Workflow

» This setting determines the number of days an invoice stays in the workflow before it is
flagged in the Invoice Task Center. Invoices that are flagged are highlighted in orange in the
grid.

Non-PO Invoice Import Specification

» This setting determines which non-PO invoice import specification is used.
Purchase Order Invoice Import Specification

» This setting determines which PO invoice import specification is used.
Work Order Invoice Import Specification

* This setting determines which WO invoice import specification is used.
Default Item Category for Free Form Items

» This setting displays the default item category selected for free form items.

3.1.2 PO Reconciliation Invoice Settings

Account Code Type to Verify Invoice Udef 1 Entry

» This setting allows the setup of a custom verification method for account codes. This setting is

dependent on the organization’s accounting practices.

* Specify which type of account codes (in the accounting codes table) the entry in Invoice Udef 1
field is to be verified.

Account Code Type to Verify Invoice Udef 2 Entry

» This setting allows the setup of a custom verification method for account codes. This setting is

dependent on the organization’s accounting practices.

» Specify which type of account codes (in the accounting codes table) the entry in Invoice Udef 2
field is to be verified.

Account Code Type to Verify Invoice Udef 3 Entry

» This setting allows the setup of a custom verification method for account codes. This setting is

dependent on the organization’s accounting practices.

» Specify which type of account codes (in the accounting codes table) the entry in Invoice Udef 3
field is to be verified.

Account Code Type to Verify Invoice Udef 4 Entry
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» This setting allows the setup of a custom verification method for account codes. This setting is

dependent on the organization’s accounting practices.

» Specify which type of account codes (in the accounting codes table) the entry in Invoice Udef 4
field is to be verified.

Account Code Type to Verify Invoice Udef 5 Entry

» This setting allows the setup of a custom verification method for account codes. This setting is

dependent on the organization’s accounting practices.

» Specify which type of account codes (in the accounting codes table) the entry in Invoice Udef 5
field is to be verified.

Enable Flagging of Discrepant Purchase Orders

» This setting determines whether the Discrepancy Review process is used for PO invoices.
Enable Inspection Rejected Items for Invoicing

» This setting allows for items in the rejected receipt inspection work queue to be reconciled.
Enforce 3-Way Match

» This setting requires all three components (Purchase Order-Receipt-Invoice) to complete the
purchase to invoice process. This setting helps organizations achieve a 3-way match as dictated
by their business requirements.

Line Account Codes required in PO Reconciliation
» This setting requires an AP account code to be entered for all line items on the invoice.
Overwrite the Invoice Creator with Discrepancy Reviewer

» This setting determines the user name referenced on an invoice as the invoice creator. If set to

Yes, the last person to approve the invoice is listed as the invoice creator.
Require Freight Account Code to be Entered

» This setting requires a freight account code to be entered on the invoice. This is typically used
in conjunction with the accounting export.

Require Tax Account Code to be Entered

» This setting requires a tax account code to be entered on the invoice. This is typically used in
conjunction with the accounting export.

Restrict Invoice Line Items to 2 Decimals

» This setting determines the number of decimals displayed. When enabled, line items are
extended by two decimal points. When disabled the line items are extended by four decimal

points.
Stop Reconciliation of fully Reconciled Orders
» This setting prevents further action from being taken on an order that has been fully processed.

Type of Account Codes to Verify the AP Account Code
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* This setting determines whether AP account codes are verified against standard accounting

codes instead of AP specific account codes.
Update Inventory Item Cost on Reconcile

» This setting determines whether reconciliation changes the associated inventory cost.

» This setting is enabled if average costing is used by your organization. If enabled, the inventory
value changes when the invoice price differs from the purchase order price. If not enabled then
the inventory value does not change when the invoice price differs from the purchase order
price.

» The use of this setting requires companies to evaluate how their reconciliation process works in

conjunction with inventory costs.

The following scenario may occur if this setting is enabled. One catalog item (ABC) is ordered for $10
and this information is placed on the purchase order. The Vendor sends an invoice for $20 due to a recent
price change. If this setting is enabled then when the accounting department reconciles the PO the new

catalog price is updated to $20.

However, what happens if a price discount is received from the vendor for a bulk purchase? The new
invoice cost information may only apply to a special promotion or a price discount for bulk. The
organization process may not want the accounting department to be able to change the catalog price for
item ABC since the new price could be incorrect if future purchases are not bulk or do not fall within the

parameters of a promotional campaign.

This setting requires the organization to think about the relationship between accounting and the
purchasing department. Is accounting to have the ability to change price information for inventory items

during reconciliation?
Update Vendor Pricing during Reconciliation

» This setting affects the cost of an item in the catalog. If Yes is selected then the new item price
is automatically updated in the master item catalog. If No is selected then any adjustments
made to the vendor price are not be added and saved.

» Enabling this setting may update the price of an item when reconciliation is performed. If the
PO price and the invoice price do not match, then the catalog price is automatically updated to
match the cost of the invoice. The only exception to this case is when the system and the
contract do not allow price updates during the reconciliation process.

» Enabling this setting may reduce catalog maintenance time for the catalog manager. However,

at the same time, the catalog manager loses some control over catalog price updates.
Verify Freight Account Codes against Standard Account Codes

» This setting determines whether freight account codes are verified against standard accounting

codes instead of freight specific account codes.
Wait Period for Receiving when Using e-Invoicing

» This setting controls the number of days after which an invoice is rejected due to non-receipt of

goods.
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3.1.3 PO Discrepancy Invoice Settings

Compare entered Invoice Total and Calculate PO Total for PO Discrepancy

» If the organization uses the discrepancy review process, this setting is used to determine if the

discrepancy check is made against invoice totals or against individual item costs.
Enable Discrepancy for Invoice Overage Only

» This setting is enabled only if the organization requires flagging POs for discrepancy when the
invoice total is greater than the PO total. When this setting is set to Yes, any invoice that has a

total less than the PO total is not considered discrepant.
Enable Notification for Invoice Resolution to Invoice Creator

» This setting determines whether a message is sent to the invoice creator when a discrepant

invoice has been accepted or rejected.
Include Freight Amount to flag PO Discrepancy

» This setting determines whether freight charges are factored in for discrepancy flagging.

» This setting affects the reconciliation process. If the setting is set to Yes, then the freight
charges are factored in. If the setting is No, then the freight charges are not factored in.

» Itis the company’s decision to decide whether these charges are factored in for flagging during

the reconciliation process.
Max % Diff to flag PO Discrepancy

» This setting determines the allowed percentage difference between the PO total and reconciled
total without a discrepancy flag.

» This setting is a percentage value expressed as a number. If the setting enable flagging of
discrepant purchase order’s is enabled, then the discrepancy review process uses this setting to
determine if an invoice needs review. If the percentage of discrepancy is greater than this
setting value, then the invoice is flagged for discrepancy. If this value is set to zero, then all
invoices that have a discrepancy are flagged.

» The present value useful for discrepancies involving purchase orders with smaller item costs.

« Companies are interested in pricing discrepancies. Pricing discrepancies are often the result of
human error (e.g. pricing added incorrectly to the system) and vendor catalog updates. If
companies have contractual obligations with vendors, then price variation becomes a focal
point of cash flow management. However, the company must make a managerial decision in
terms of what percentage in price difference warrants investigation. For example, an item price
might be listed at $10.00, yet the invoice from the vendor reads $10.02. This difference may
not warrant the allocation of additional labor time in order to find the cause. This price
difference may become instrumental if order quantities are large. Management must determine

a suitable percentage difference for the system to flag an item.

Max Amount Diff to flag PO Discrepancy
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» This setting determines the allowed absolute amount between the PO total and reconciled total

without a discrepancy flag.

» This setting is a numeric value. The setting determines the maximum discrepancy allowed in
dollars between the PO created in the system and the corresponding invoice. This setting works
in conjunction with the previous setting to determine if a discrepancy has occurred.

*  When the actual discrepancy exceeds either value, the invoice is marked for review. This
setting is used for POs with higher item costs and/or higher total costs.

» This setting serves as a cross check against the Max % Diff setting described previously. For
example, a single item PO total is $100 and the Max % difference is set to ten percent. The
accounting department receives an invoice for $108 for the item. Under the Max % setting of
10%, a flag is not being created for this PO. Now, expand the problem and state that 1000 units
of the item were ordered at $100 per unit. The total order would be $100,000, yet the invoice
from the vendor would be $108,000. This might be an unacceptable difference for the
company's accounting department without further investigation. If the absolute dollar amount
setting was set to $3.00, then a flag appears automatically and further investigation is started
earlier in the accounting process. The combination of the max percentage difference setting and

the max amount difference setting is a powerful discrepancy detection tool.
Use Only Line Item Unit Cost to flag PO Discrepancy

» This setting determines whether tax is included in the discrepancy calculation.

*  When the setting is enabled, then only discrepancies for individual item costs are reviewed. If

the setting is not enabled, then taxes are included during the discrepancy review process.

» This setting must be used if the company’s discrepancy review process includes taxes and the
setting set to No. If item cost discrepancies are the primary concern, then this setting should be
Yes.

3.1.4 WO Reconciliation Invoice Settings

Default Work Order Type for Open Service Invoice
» This setting determines the default WO type for service items.
Service Invoice Discrepancy Review Type

» This setting determines the type of user to review WO discrepancies.

3.1.5 WO Discrepancy Invoice Settings

Enable Discrepancy for Assets under Warranty

» Discrepancy review is triggered for service invoice line items that are for assets under warranty

when set to Yes.

Enable Discrepancy if Line Item Asset does not Match Work Order
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» Service invoice line items are flagged for discrepancy if line item assets do not match an asset

on the work order when set to Yes.
Enable Discrepancy if no Asset Specified

» Service invoice line items are flagged for discrepancy if line item is not associated with an

asset when set to Yes.
Flag Discrepancy for Asset/WO Location mismatch

*  When a location mismatch between assets and work orders occur the discrepancy is flagged

when set to Yes.
History Days for Discrepancy Review

» The number of days used to check service history of an asset to determine if it is flagged for

discrepancy. Leave blank for no discrepancy.
Invoice Labor Total Amount for Automatic Discrepancy

» This setting determines the amount for the total of labor line items to trigger discrepancy. Enter
the amount in the field to trigger the discrepancy. Leave this field blank if this discrepancy

review is not needed.
Invoice Parts Total Amount for Automatic Discrepancy

» This setting determines the amount for part for the total parts line items to trigger discrepancy.
Enter the amount in the field to trigger the discrepancy. Leave this field blank if this

discrepancy review is not needed.
Invoice Total Amount for Automatic Discrepancy

» This setting determines the total invoice amount of a WO invoice to trigger a discrepancy
review. Enter the amount in the field to trigger the discrepancy. Leave this field blank if this

discrepancy review is not needed.
Line Item Labor Amount for Automatic Discrepancy

» This setting determines the line item amount for labor to trigger a discrepancy review. Enter
the amount in the field to trigger the discrepancy. Leave this field blank if this discrepancy

review is not needed.
Line Item Labor Quantity for Automatic Discrepancy

» This setting determines the line item quantity for labor to trigger a discrepancy review. Enter
the amount in the field to trigger the discrepancy. Leave this field blank if this discrepancy

review is not needed.
Line Item Labor Total Amount for Automatic Discrepancy

» This setting determines the total of the labor line item amount to trigger a discrepancy review.
Enter the amount in the field to trigger the discrepancy. Leave this field blank if this

discrepancy review is not needed.

Line Item Part Amount for Automatic Discrepancy
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» This setting determines the line item part amount to trigger a discrepancy review. Enter the

amount in the field to trigger the discrepancy. Leave this field blank if this discrepancy review

is not needed.
Line Item Part Quantity for Automatic Discrepancy

» This setting determines the line item quantity for parts to trigger a discrepancy review. Enter
the amount in the field to trigger the discrepancy. Leave this field blank if this discrepancy

review is not needed.
Line Item Parts Total Amount for Automatic Discrepancy

» This setting determines the total of the parts line item amount to trigger a discrepancy review.
Enter the amount in the field to trigger the discrepancy. Leave this field blank if this

discrepancy review is not needed.

3.1.6 Layout Invoice Settings

Custom Invoice Template File
» This defines the location of the customized invoice entry files.
» Example: custom/customerABC/UIE.cfm
Custom View Invoice Template File

» This defines the preview template file location to view the invoice during entry when

customized.

Enable browser scroll bar during invoice entry

» This determines whether the browser scroll bar is visible on the Invoice Entry page.
Invoice Approval Attachment Module Path

» This determines the path to use when the invoice approval attachment module is customized.
Invoice Approval Budget Module Path

» This determines the path to use when the invoice approval budget module is customized.
Invoice Approval Detail Module Path

* This determines the path to use when the invoice approval detail module is customized.
Invoice Approval Distribution Module Path

» This determines the path to use when the invoice approval distribution module is customized.
Invoice Approval Header Module Path

» This determines the path to use when the invoice approval header module is customized.

Invoice Approval Module Path
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» This invoice setting is used to display the approval header and detail information on the same
page.
* Enter the following information in the Path field:

o ././swfs/Approvelnvoice/modules/MinvoiceView WithDtls.swf
Invoice Approval Notes Module Path

» This determines the path to use when the invoice approval notes module is customized.
Invoice Approval Route Module Path

» This determines the path to use when the invoice approval route module is customized.
Invoice Approval Vendor Module Path

* This determines the path to use when the invoice approval vendor module is customized.
Invoice Approve Module Path

* This determines the path to use when the invoice approve module is customized.
Invoice Entry Module Path

» This invoice setting is used to display the invoice entry header and detail header information on
the same page when the user accesses the Invoice Entry page from the Purchase Order
Administration page.

» Enter the following information in the Path field:

o ./../swis/UIE/modules/MinvoiceEntryWithDtls.swf

Invoice Entry Style Sheet Path

» This determines the path to use when the invoice entry style sheet is customized.
Invoice Manager Attachment Module Path

» This determines the path to use when the Invoice Manager Attachment module is customized.
Invoice Manager Detail Module Path

» This determines the path to use when the Invoice Manager Detail module is customized.
Invoice Manager Distribution Module Path

» This determines the path to use when the Invoice Manager Distribution module is customized.
Invoice Manager Entry Module Path

» This setting is used to display the invoice entry header and detail information on the same page
when the user accesses the Invoice Entry page from the Invoice Entry tab.
» Enter the following information in the Path field:

» ././swfs/InvoiceManager/modules/MinvoiceEntry WithDtls.swf
Invoice Manager Header Module Path
» This determines the path to use when the Invoice Manager Header module is customized.

Invoice Manager List Module Path
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» This determines the path to use when the Invoice Manager List module is customized.

Invoice Manager Notes Module Path

» This determines the path to use when the Invoice Manager Notes module is customized.
Invoice Manager Search Module Path

* This determines the path to use when the Invoice Manager Search module is customized.
Invoice Manager Vendor Module Path

» This determines the path to use when the Invoice Manager Vendor module is customized.
Invoice Manager View Attachment Module Path

» This determines the path to use when the Invoice Manager View Attachment module is

customized.
Invoice Manager View Detail Module Path
» This determines the path to use when the Invoice Manager View Detail module is customized.
Invoice Manager View Distribution Module Path

» This determines the path to use when the Invoice Manager View Distribution module is

customized.
Invoice Manager View Header Module Path
» This determines the path to use when the Invoice Manager View Header module is customized.
Invoice Manager View Module Path

» This setting is used to display the invoice header and detail information on the same page when
the user views the invoice from the Invoice Manager module.
* Enter the following information in the Path field:

o ././swfs/InvoiceManager/modules/Minvoice ViewWithDtls.swf
Invoice Manager View Notes Module Path

» This determines the path to use when the Invoice Manager View Notes module is customized.
Invoice Manager View Vendor Module Path

» This determines the path to use when the Invoice Manager Vendor module is customized.
Invoice Module Path

» This determines the path to use when the invoice module is customized.
Invoice Notes Module Path

» This determines the path to use when the invoice notes module is customized.
Invoice Search Module Path

» This determines the path to use when the invoice search module is customized.

Invoice Template Path
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* This determines the path to use when the invoice template is customized.

Invoice Vendor Module Path

» This determines the path to use when the invoice vendor module is customized.
Invoice View Attachment Module Path

» This determines the path to use when the invoice view attachment module is customized.
Invoice View Detail Module Path

* This determines the path to use when the invoice view detail module is customized.
Invoice View Distribution Module Path

» This determines the path to use when the invoice view distribution module is customized.
Invoice View Header Module Path

» This determines the path to use when the invoice view header module is customized.
Invoice View Module Path

» This setting is used to display the invoice header and detail information on the same page when
the user views the invoice from the Purchase Order Administration Page.
* Enter the following information in the Path field:

» .././swfs/Viewlnvoice/modules/MinvoiceView WithDtls.swf
Invoice View Notes Module Path

» This determines the path to use when the invoice view notes module is customized.
Invoice View Vendor Module Path

» This determines the path to use when the invoice view vendor module is customized.
Purchase Order Template Path

» This determines the path to use when the purchase order template is customized
Task Center Flow Module Path

» This invoice setting is used to display the Invoice Task Center vertically.
» This invoice setting works in conjunction with Task center List Module Path.

» Enter the following information in the Path field: ../../swfs/InvoiceManager/modules/

MinvoiceVTaskFlow.swf
Task Center List Module Path
This invoice setting is used to display the Invoice Task Center vertically.

» This invoice setting works in conjunction with Task Center Flow Module Path.
* Enter the following information in the Path field:

o ././swfs/InvoiceManager/modules/MinvoiceVTaskList.swf

Vendor Template Path
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* This determines the path to use when the vendor module is customized.

Work Order Template Path

* This determines the path to use when the work order template module is customized.

3.2 Invoice Setting Addition and Editing

The Invoice Setting Wizard is used to add or edit invoice settings. Users can access it using the Add or
Edit actions on the Invoice Settings List page.

Invoice Setting Wizard Invoice Setting Type Step 10f 4

Select Setting Type *

PO Reconcilation

PO Discrepancy
WO Reconcilation
WO Discrepancy
Layout

Figure 12: Add Invoice Setting — Step 1 page

Invoice Setting Wizard Invoice Setting Type Step 2 0f 4

Select Setting* | check Budget Availability for Non-PO Invoice

<gack I Next>

Figure 13: Add Invoice Setting — Step 2 page

Invoice Setting Wizard Select Invoice Setting Level - Image reference URL Step 3 0f 4

Select Setting Level* Al

=1

<Back | Next>

Figure 14: Add Invoice Setting — Step 3 page

ﬂ Invoice Setting Wizard step 4 varies depending on the invoice setting and other options
selected in steps 1, 2, and 3.
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3.2.1 Adding Invoice Settings

To add an Invoice Setting:

-E- 1. From the Dashboard, navigate to ﬁ. " > Invoice > Invoice Settings.
2. Click Add.

W

In step 1 of the Invoice Setting Wizard, select the setting type that corresponds with the
setting to add.

Click Next.
In step 2 of the Invoice Setting Wizard, select the setting to be enabled.
Click Next.

NS vk

In step 3 of the Invoice Setting Wizard, select whether the invoice setting needs to be
configured based on vendor, item, item category, asset category, or all. If all is selected, it
is used as a global setting for all vendors and categories.

ﬂ Not all options are available for all system settings.

8. Click Next.
9. Instep 4 of the Invoice Setting Wizard, set the fields available. These fields vary

depending on the invoice setting selected.

10. Click Finish.

The added setting is displayed in the Invoice Settings List page.

3.2.2 Editing Invoice Settings

The options chosen in steps 1 and 2 of the Invoice Setting Wizard cannot be edited. If you wish
to change those selections, create a new invoice setting.

To edit an invoice setting:

-E- 1. From the Dashboard, navigate to ﬁ " > Invoice > Invoice Settings.
2. From the Invoice Settings List page, select the setting to edit and click Edit Setting.

3. Instep 3 of the Invoice Setting Wizard, select whether the invoice setting needs to be
configured based on vendor, item, item category, asset category, or all. If all is selected, it
is used as a global setting for all vendors and categories.
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ﬂ Not all options are available for all system settings.

4. Click Next.

5. Instep 4 of the Invoice Setting Wizard, set the fields available. These fields vary
depending on the invoice setting selected.

6. Click Finish.

3.3 Enabling or Disabling Invoice Settings

To enable or disable an Invoice Setting:

1. From the Dashboard, navigate to ﬂ' ” > Invoice > Invoice Settings.

2. From the Invoice Settings List page, select the desired option:

* Disable Setting turns off the invoice setting but does not delete it.

* Enable Setting reactivates an invoice setting that was previously disabled.

3.4 Deleting Invoice Settings

To delete an invoice setting:

1. From the Dashboard, navigate to ﬂ' ” > Invoice > Invoice Settings.
2. From the Invoice Settings List page, select the setting to delete and click Delete.

3. Click OK on the pop-up verification window
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4 Account Code Templates

Account Code templates allow users to group account codes together that are used frequently for

invoicing.

For information on using Account Code Templates for invoice entry, see Invoice Manager User Guide -
Chapter 7.

The following permission is required to manage Account Code templates.

* 3509 — Can Manage GL Templates

Account Code Template List

Fitter | Keywords Submit

24 - Accounts Coding

Edit

Delete

Import

S
g8

Export

Showing 1 item(s)

Figure 15: Account Code Template Management page

Action Definition

Add Allows the user to add a new account code
template.

Edit Allows the user to edit an existing account code
template.

View Allows the user to view an existing account code
template.

Delete Allows the user to delete an account code
template.

Import Allows the user to import an account code
template.

The import spec for an accounting code
template must be created before this
feature can be used.

Export Allows the user to export an account code
template.
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4.1 Account Code Template Addition and Editing

The Add Account Code Template page and the Edit Account Code Template page have similar attributes.

Add/Edit Account Code Template

Name *

Type oy ]

ot a
Notes

Default o

Accounts Coding * Percentage (0-1) Notes Acti

Location - site

- oo scnov0 =3

Figure 16: The Add/Edit Account Code Template page

Field Name Definition

Name* Enter the name of this account code template. This
is a required field. Example: Phone Bill

Type Select the type for this account code template. The
available options are any, PO invoice, non-PO
invoice, WO invoice, purchase order, and request.

Vendor Select the vendor for this account code template.

Notes Enter any notes that are relevant to this account
code template.

Default Check this box if this template is to be the default
template for the values selected. This only applies
for header distribution.

4.1.1 Adding an Account Code Template

There can only be one default template for each type. The default template only works for header
distribution.

To add an account code template:

1. From the Dashboard, navigate to 'u - Accounting > Account Code Template.
Click Add.

Enter the name for the account code template in the Name field.

Select the type for the account code template.

Select a vendor if applicable.

Enter any notes if needed.

N kv

Select the default checkbox if this is to be the default account code template for the type

selected.

8.  Enter an account code and its percentage in their respective fields.
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ﬂ Account code templates can be created without specifying the split percentages.
Users enter the account code in the Account Code field and 0 in the Percentage
field.

9. Click Add.
10. Repeat until the percentage equals 100.
11. Click Done when finished.

4.1.2 Editing an Account Code Template

To edit an Account Code template:

1. From the Dashboard, navigate to {} - Accounting > Account Code Template.
2. Click Retrieve.
3. Select the account code template that is to be edited.
4. Click Edit.
The Add/Edit Account Code Template page is displayed.
5. Edit the necessary information.

6. To edit the account codes and percentages, click Delete to remove the current codes and
then add the new codes and percentages.

The account code codes and percentages are deleted.
7. Click Add.
8. Repeat until the percentage equals 100.
9. Click Done.

4.2 Viewing an Account Code Template

Add/Edit Account Code Template

Name Accounts Coding

Vendor Event

Notes

Accounts Coding * Percentage (0-1) * Notes
AC5G-01ACS 0.6000

AC2G-02Ac2 0.4000

Total: 1.0000

Figure 17: View Account Code Template page

To view an account code template:

1. From the Dashboard, navigate to {} T > Accounting > Account Code Template.
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2.  Click Retrieve.

3. Select the account code template that is to be viewed.

4. Click View.

4.3 Deleting an Account Code Template

To delete an account code template:

1. From the Dashboard, navigate to ﬂ' - Accounting > Account Code Template.
Click Retrieve.
Select the account code template that is to be deleted.

2
3.
4. Click Delete.
5

Click OK in the confirmation pop-up.

4.4 Exporting an Account Code Template

Existing account code templates can be exported from the system as a .csv file.

Al = J || ACCCODE

Al 8 | ¢ | b | E | F | & | H | v | 4 K L | M | N | © P
ACCCODEIACCDISTI'I FLAGDEFAMNOTES  SPLITPERCTEMPLATE TEMPLATE VENDORN VENDOR_ID
AC5G-01A1 Accounts ! o 0.6 1 Event 2261
Ac2G-02A1 Accounts 1 o 0.4 1 Event 2261

A AT il il il il sl el el

16]

Figure 18: CSYV file for account code template export

To export an Account Code template:

1. From the Dashboard, navigate to ﬂ' - Accounting > Account Code Template.
2. Select the account code template that is to be exported.
3. Click Export.
4. Click Save.
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5. Select the location where to save the file.

6. Enter the file name in the File Name field.
7. Click Save.
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5 Invoice Types

Invoice types are a way to categorize invoices.
The following permission is required to manage invoice types.

* 3510 — Manage Invoice Types

Invoice Type List

Filter Active [keywords Submit

- 104 Invoice Type Rule
-1 Default 1
-3 Default

Delete

5
2

Disable

Showing Active records. 3 item(s)

Figure 19: Invoice Type Management page

ﬂ An asterisk to the left of the invoice type means that it is the default invoice type.

Action Definition

Add Allows the user to add a new invoice type.

Edit Allows the user to edit an existing invoice type.
View Allows the user to view an existing invoice type.
Delete Allows the user to delete an invoice type.

Enable Allows the user enable an inactive invoice type.
Disable Allows the user to disable an active invoice type.

5.1 Invoice Types Addition and Editing

The Add Invoice Type page and the Edit Invoice Type page have similar attributes.
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Add/Edit Invoice Type

Invoice Type Name *

Owner n

Notes

Default @ Yes O No

Enabled @ Yes O No

Add/Edit Invoice Type Clear Entries

Figure 20: The Add/Edit Invoice Type page

Field Name Definition

Invoice Type Name* Enter the name of the invoice type. This is a
required field. Example: Debit Memo

Owner Select the owner for this invoice type.

ﬂ Invoice spend rules can be filtered by

invoice type owners.

Notes Enter any notes that are relevant to this invoice
type.
Default Select Yes if this invoice type is to be the default

invoice type.

Only one invoice type can be the
default.

Enabled Select Yes if this invoice type is to be enabled.
Select No if this invoice type is to be disabled.

5.1.1 Adding an Invoice Type

To add an invoice type:

1. From the Dashboard, navigate to 'n. " > Invoice > Invoice Types.
Click Add.

Enter the name for the invoice type in the Invoice Type Name field.

2
3
4.  Select the owner for the invoice type.
5. Enter any notes if needed.

6

Select the Yes radio button if this is to be the default invoice type.
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ﬂ There can only be one default invoice type.

7. Select the Yes radio button if this invoice type is to be enabled.

8. Click Add/Edit Invoice Type.

5.1.2 Editing an Invoice Type

To edit an invoice type:

1. From the Dashboard, navigate to ﬁ " > Invoice > Invoice Types.

Select the invoice type that is to be edited.

Edit the necessary information.

2
3. Click Edit.
4
5

Click Add/Edit Invoice Type.

5.2 Viewing an Invoice Type

View Invoice Type

Invoice Type Name *
Owner

Notes

Default

Enabled

Invoice Type Rule

Admin (4)

No

Yes

Figure 21: View Invoice Type page

To view an invoice type:

1. From the Dashboard, navigate to 'u ” > Invoice > Invoice Types.

2. Select the invoice type that is to be viewed.

3. Click View.

5.3 Deleting an Invoice Type

To delete an invoice type:
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a.

2
3.
4

From the Dashboard, navigate to ﬁ " > Invoice > Invoice Types.

Select the invoice type that is to be deleted.
Click Delete.
Click OK in the confirmation pop-up.

5.4 Enabling an Invoice Type

To enable an invoice type:

a.

2
3.
4

From the Dashboard, navigate to 'u ” > Invoice > Invoice Types.

Filter for inactive invoice types.
Select the invoice type that is to be enabled.
Click Enable.

5.5 Disabling an Invoice Type

To disable an invoice type:

a.

2
3.
4

From the Dashboard, navigate to 'u ” > Invoice > Invoice Types.

Filter for active invoice types.
Select the invoice type that is to be disabled.
Click Disable.
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6 Invoice Rejections

The invoice rejection list is a predetermined list of reasons why an invoice is rejected during invoice

approval. The field(s) to select the invoice rejection reason are set up in the invoice approval mask.
The following permission is required to manage invoice rejections.

* 3513 — Manage Invoice Rejections

Invoice Rejection List

Filter| Active [keywords Submit

* - 37 Pavels Rejection
-38 second Rejection
-2NA

Disable

Showing Active records. 3 item(s)

Figure 22: Invoice Rejection Management page

ﬂ An asterisk to the left of the invoice rejection means that it is the default invoice rejection.

Action Definition

Add Allows the user to add a new invoice rejection.

Edit Allows the user to edit an existing invoice
rejection.

View Allows the user to view an existing invoice
rejection.

Delete Allows the user to delete an invoice rejection.

Enable Allows the user enable an inactive invoice
rejection.

Disable Allows the user to disable an active invoice
rejection.

6.1 Invoice Rejection Addition and Editing

The Add Invoice Rejection page and the Edit Invoice Rejection page have similar attributes.
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Add/Edit Invoice Rejection

Invoice Rejection Name *
Notes

Reason Required @ Yes (O No
Default @® Yes (O No

Enabled @® Yes (O No

Add/Edit Invoice Rejection Clear Entries

Figure 23: The Add/Edit Invoice Rejection page

Field Name Definition

Invoice Rejection Name* Enter the name of the invoice rejection. This is a
required field. Example: Service not Acceptable

Notes Enter any notes that are relevant to this invoice
rejection.

Reason Required Select Yes if a reason is required for this rejection.
Select No if a reason is not required for this
rejection.

Default Select Yes if this invoice rejection is to be the

default invoice rejection. Select No if this not to be
the default invoice rejection.

Only one invoice rejection can be the
default.

Enabled Select Yes if this invoice rejection is to be enabled.
Select No if this invoice rejection is to be disabled.

6.1.1 Adding an Invoice Rejection

To add an invoice rejection:

1. From the Dashboard, navigate to ﬂ. " > Invoice > Invoice Rejections.
Click Add.

Enter the name for the invoice rejection in the Invoice Rejection Name field.

2

3

4. Enter any notes if needed.

5. Select the Yes radio button if a reason is required for this invoice rejection.
6

Select the Yes radio button if this is to be the default invoice rejection.

ﬂ There can only be one default invoice rejection.
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7.  Select the Yes radio button if this invoice rejection is to be enabled.

8.  Click Add/Edit Invoice Rejection.

6.1.2 Editing an Invoice Rejection

To edit an invoice rejection:

1. From the Dashboard, navigate to ﬂ' ” > Invoice > Invoice Rejections.
2. Select the invoice rejection that is to be edited.
3. Click Edit.
4. Edit the necessary information.
5. Click Add/Edit Invoice Rejection.

6.2 Viewing an Invoice Rejection

View Invoice Rejection

Invoice Rejection Name Second Rejection
Notes Second Rejection
Reason Required Yes
Default No

Enabled Yes

Figure 24: View Invoice Rejection page
To view an invoice rejection:
1. From the Dashboard, navigate to ﬂ' ” > Invoice > Invoice Rejections.

2. Select the invoice rejection that is to be viewed.

3. Click View.

6.3 Deleting an Invoice Rejection

To delete an invoice rejection:

1. From the Dashboard, navigate to ﬂ. " > Invoice > Invoice Rejections.

2. Select the invoice rejection that is to be deleted.
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3.  Click Delete.

4. Click OK on the confirmation pop-up.

6.4 Enabling an Invoice Rejection

To enable an invoice rejection:

1. From the Dashboard, navigate to ﬂ' ” > Invoice > Invoice Rejections.
2. Select the invoice rejection that is to be enabled.

3.  Click Enable.

6.5 Disabling an Invoice Rejection

To disable an invoice rejection:

1. From the Dashboard, navigate to ﬂ. " > Invoice > Invoice Rejections.
2.  Filter for active invoice rejection.
3. Select the invoice rejection that is to be disabled.
4

Click Disable.
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7 Invoice Exceptions

Invoice exception is a predetermined list of reasons why an invoice cannot be processed and is sent to a
pre-process work queue. To learn more about work queues please read Chapter 2 of the General User
Guide.

The following permission is required to manage invoice exceptions.

* 3512 — Manage Invoice Exceptions

Invoice Exception List

Filter SthAll [keywords Submit

-2 |
Edit
View

Delete

Disable

showing Show All records. 1 item(s)

Figure 25: Invoice Exception Management page

ﬂ An asterisk to the left of the invoice exception means that it is the default invoice exception.

Action Definition

Add Allows the user to add a new invoice exception.

Edit Allows the user to edit an existing invoice
exception.

View Allows the user to view an existing invoice
exception.

Delete Allows the user to delete an invoice exception.

Enable Allows the user enable an inactive invoice
exception.

Disable Allows the user to disable an active invoice
exception.
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7.1 Invoice Exception Addition and Editing

The Add Invoice Exception page and the Edit Invoice Exception page have similar attributes.

Add/Edit Invoice Exception

Invoice Exception Name *

Notes
Skip Validation @® Yes (O No
Default @® Yes (O No
Enabled @ Yes (O No

Add/Edit Invoice Exception Clear Entries

Figure 26: The Add/Edit Invoice Exception page

Field Name Definition

Invoice Exception Name*

Enter the name of the invoice exception. This is a
required field. Example: Image not Available

Notes

Enter any notes that are relevant to this invoice
exception.

Skip Validation

Select Yes if validation is to be skipped. Select No
if validation is not to be skipped.

Default

Select Yes if this invoice exception is to be the
default invoice exception. Select No if this not to
be the default invoice exception.

Only one invoice exception type can be
the default.

Enabled

Select Yes if this invoice exception is to be
enabled. Select No if this invoice exception type is
to be disabled.

7.1.1 Adding an Invoice Exception

To add an invoice exception:

a.

Click Add.

From the Dashboard, navigate to ﬂ. ” > Invoice > Invoice Rejections.

2
3. Enter the name for the invoice exception in the Invoice Exception Name field.
4

Enter any notes if needed.
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5. Select the Yes radio button if validation is to be skipped.

6. Select the Yes radio button if this is to be the default invoice exception.

ﬂ There can only be one default invoice exception.

7.  Select the Yes radio button if this invoice exception is to be enabled.

8. Click Add/Edit Invoice Exception.

7.1.2 Editing an Invoice Exception

To edit an invoice exception:

1. From the Dashboard, navigate to ﬁ ” > Invoice > Invoice Rejections.
2. Select the invoice exception that is to be edited.
3. Click Edit.
4. Edit the necessary information.
5. Click Add/Edit Invoice Exception.

7.2 Viewing an Invoice Exception

View Invoice Exception

Invoice Exception Name NA
Notes

Skip Validation No

Default No

Enabled Yes

Figure 27: View Invoice Exception page
To view an invoice exception:
1. From the Dashboard, navigate to ﬁ. " > Invoice > Invoice Rejections.

2. Select the invoice exception that is to be viewed.

3.  Click View.
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7.3 Deleting an Invoice Exception

To delete an invoice exception:

1. From the Dashboard, navigate to ﬁ " > Invoice > Invoice Rejections.
2. Select the invoice exception that is to be deleted.
3. Click Delete.
4. Click OK in the confirmation pop-up.

7.4 Enabling an Invoice Exception

To enable an invoice exception:

1. From the Dashboard, navigate to 'u ” > Invoice > Invoice Rejections.
2. Filter for inactive invoice exceptions.
3. Select the invoice exception that is to be enabled.
4

Click Enable.

7.5 Disabling an Invoice Exception

To disable an invoice exception:

1. From the Dashboard, navigate to 'u ” > Invoice > Invoice Rejections.
2. Filter for active invoice exceptions.
3. Select the invoice exception that is to be disabled.
4

Click Disable.

© Copyright 1999-2018 Basware Corporation. All rights reserved.. 47



basware Basware P2P 18.2

8 E-Invoice Manager

E-Invoice manager allows users to streamline processing of invoices in electronic formats such as c XML

and EDI invoices.

The validation for e-invoices is a two-step process. The first step is submission validation, and the second

step is processing validation.

If e-invoices fail validation and cannot be processed, the system moves the incorrect e-invoices to an
inbound work queue for the appropriate source and proceeds with processing the rest of the invoices in
the batch.

The following system setting is required to manage archived files:

* 4055 — Number of Days to Keep Archived E-Invoice Documents

8.1 E-Invoice Process Flow

The processing steps for e-invoices that are submitted to the system are as follows:

1. Invoices sent electronically from vendors are dropped in a drop box that is managed using the
File Manager capabilities.

2. Invoices are picked up from the drop box by a reader process that reads the documents and
stores the information in a temporary table. This process performs a credential validation or
origin validation depending on the type of document being read.

3. Once the invoices are read, they are available in the E-invoice Manager.

4. After the credentials or origins are validated, a generic processor (that is not dependent on the
document source) processes the invoices and creates the invoices in the system for further
processing.

5. E-invoices without any errors are placed in the invoice workflow.

6. E-invoices with errors are placed in the inbound work queue to be manually corrected.

8.1.1 File Manager

The file structure needed for the drop box is created and maintained through a scheduled task. It is
managed through the system’s file manager. The file structure for archive-failure and archive-success
folders includes a file type and date structure. Files in these folders are sorted by file type > year > month
> day. The file structure for the in, out, and staging folders include just a file type structure. The staging
folder is for files that do not go through the initial validation process. An example of a file not going

through the initial validation process is directly performing a file transfer (FTP) to the server.

© Copyright 1999-2018 Basware Corporation. All rights reserved.. 48



basware Basware P2P 18.2

E"ﬂ!ml Date medified Type Cige
: ] 619,201 20829145816 _TCEEIBBCR3CICAR0... 8/29/2012 10:58 AM XML Docurment T
] 619, 2002082915147 TDSS0EABMFIERSD... 5/29/2012 1110 A XML Docusment S KB
;) 619,200 2080153000 TEOBCCEECIONAI9..  B/29/2012 1130 AM XML Docurment KB
12 619,201 20829160506 PRIDMASALAN0RD.. B/29/20121205PM XML Decurment S KE
= 619_20120829165236 BOFCEABABASCEEDS... §/20/201212:52FM XML Decurment S KB
;, 619 20208172904 BHCHBIBEBIZECF... &/ 2012 129 PM XML Document SEB

Figure 28: Archive Success — e-invoice file structure

8.1.2 Drop Box

When vendors send files to the system via HTTP or FTP, the system stores the files in a temporary

holding area. From here, the e-invoicing reader picks up the files to read for credential validation.
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response - file
received
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Figure 29: Drop Box workflow

8.1.3 Document Reader

The system has a common reader that reads stored files in the drop box and stores files temporarily for
credential validation and e-invoice validation. If an error occurs (file is unreadable, unsupported, etc.) the

system archives the file and sends the appropriate e-mail notifications. This reader is run through a
scheduled task.
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Figure 30: Common Reader for credential validated files

8.1.4 Processor

No

|

System sends
process response
(success and
failures)

4% End

After the files are read, the data is processed, extracted, and transferred to the database. A common

processor analyzes and validates the data. If the initial validations pass, the system creates an invoice for

further processing.
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Figure 31: Common Processor workflow

8.1.5 Credential Validation

For e-invoice documents that require credential information to be included in the document, it is
important to store the credential information in the system so that it can be used to validate the sender and
receiver information. This information is stored in the e-invoice Vendor Attributes located under Vendor

Management.

The system validates the origin of information for electronic documents that do not require or have

credential information.

Validation

The system expects the information listed below to be associated with the tenant and the invoice sender.
The credential information is generated manually and shared between the buyers and the vendors offline.

* System Credential Domain
* Credential Identity

* Credential Domain

* System Sender Domain

» Sender Domain Identity

» Sender Domain Secret

*  Vendor Password

URL Checks

When an e-invoice is posted to an URL, the vendor can either include the tenant ID and the vendor ID in
the information or include the credential information in the file. The system performs the following
checks when an e-invoice is posted an URL:
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» Ifthe tenant ID and vendor ID are available in the URL and both are valid, the system does
not use the credential information from the file.

» Ifthe tenant ID or Vendor ID or both are missing from the URL or are incorrect, the system
looks for the credential information in the file and matches the credentials if available.

+ Ifthe credentials in the file do not match for a missing or an incorrect vendor ID in the URL,
but the tenant ID is valid, the system identifies the user who has permission 3515 (Manage e-
invoice) for the tenant and sends a notification to the user and the vendor stating the vendor ID
is invalid.

8.1.6 Electronic Submission

When an e-invoice is submitted electronically, the system uses the combination of the sender domain
identity and credential identity from the file to identify the correct tenant. If a match is found, the e-

invoice is created in the system for the tenant.

If a match is not found for the sender domain and credential identity or if the tenant and/or vendor

information in the URL is not valid, the system:

*  Archives the file.
* Makes an entry in the log file to indicate the error.

» Sends an e-mail to the global administrator. This only happens if the system is unable to

determine the tenant.

» Sends an e-mail to the tenant e-invoice manager (the user who has permission 3515) if the
tenant information is in the URL and is valid.

8.1.7 Multiple Vendor Profiles for Same Vendor

When a vendor has multiple profiles in the system and e-invoicing is used, all the vendor profiles
associated with that vendor need to have the same e-invoicing vendor attributes in their vendor profiles in

order for the system to match the PO with the correct vendor profile for that real-world vendor.
*  When an e-invoice is submitted for any of the vendors, the invoice’s vendor is temporarily set
to the vendor with the lowest vendor ID.
*  When the PO is matched, the vendor ID is updated to the correct one if necessary.

* In the event that the e-invoice cannot be matched to a PO, the invoice is sent to the EDI/ XML

Inbound work queue and a user selects the correct vendor and PO.
Example
A client may have the following vendor profiles for OfficeMax:

* OfficeMax — main profile
*  OfficeMax XML — this profile is set up to deliver POs to OfficeMax via c XML

* OfficeMax_e-mail — this profile is set up to deliver POs to OfficeMax via e-mail

When an e-invoice is submitted from OfficeMax from any of the vendors, the invoice’s vendor is
temporarily set to the vendor with the lowest vendor ID in the system. When the PO is matched, the
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vendor ID is updated to the correct one if necessary. In the event that the e-invoice cannot be matched to a

PO, the invoice is sent to the EDI/XML Inbound work queue, and a user selects the correct vendor and/or
PO.

8.1.8 High Volume Processing

The processing of bulk e-invoices is done through the database. The system handles the locking to ensure
that the high volume batches are processed efficiently and without disrupting the invoicing processing
performed by the users. The maximum number of invoices that can be processed in a scheduled run per
invoice type (cXML and EDI) is determined by hidden system setting 999200030 - No. of e-invoices to
process each cycle. The default value is 50. The processing of e-invoices is handled in their own
scheduled tasks which run by default every 10 minutes. These scheduled tasks are PITEInvoiceRead and
PITEInvoiceCheck.

8.2 E-Invoice Management

The following permission is required to manage e-invoices:

* 3515 —Manage E-Invoice

E-invoice List

Filter Show All Kkeywords Submit

Validate Invoice Filter for E-invoice Search
<]
a

Received Date mm/dd

o Tyvyy)

Showing 0 item(s)

Figure 32: Manage E-Invoice page

Action Definition

Validate Invoice Allows the user to manually validate an e-invoice.
This process validates that the e-invoice is ready to
send to the invoice workflow. If the e-invoice
contains errors, it is sent to the inbound work
queue.

Process Invoice Allows the user to process an e-invoice that is in
the system. Once processed, the invoice is placed
in the appropriate work queue.
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Action Definition

View Invoice Allows the user to the view an electronic invoice
but changes cannot be made to it.

Upload Invoice Allows the user to upload an e-invoice.
Download Invoice Allows the user to download an e-invoice
Filter/Sort

Users are able to filter by the following statuses:

» Show All — this option displays e-invoices regardless of status
* New Invoice — this option displays e-invoices that have been uploaded but not validated by the
system.

» Error — this option displays e-invoices that contain errors such as invalid PO number, missing

information, etc.
» Processed — this option displays e-invoices that have been validated by the system and are in

the pre-process work queue.

8.2.1 Validating an E-Invoice

The Validate Invoice action allows the users to validate e-invoices manually that have been stored in the
e-invoice drop box. When the e-invoices are successfully validated, they are ready to be processed and
placed in the invoice workflow. If there is an issue with the validation, the problematic invoices are
placed in the inbound work queue in the Invoice Task Center.

The validation process for e-invoices has been separated from the acceptance and read processes. The
validation process occurs on e-invoices that have been batched and are available as temporary invoices. If
an e-invoice record fails validation, an image of the e-invoice is created with the validation errors
indicated in red and the invoice is sent to the inbound EDI/XML work queue in the Invoice Task Center.
Users with permission 3502 (Manage Invoices) have the opportunity to view and correct the data on the
invoice at this stage. Users can fix an e-invoice with a PO number mismatch by using the invoice reset
functionality.

* The data for a PO e-invoice undergoes several validations; the major ones are:

* PO line ID match (If there is a match, the remainder of the line validations do not take place. If
there is no match, the line validations starting in step 2 take place).

» Duplicate invoice

* PO number match PO line match

* PO number + Item SKU + UOM combination

* PO number + Vendor item number + UOM combination

* PO number + Item description combination

* PO number + UOM + Price combination

e Free form lines

» Free form lines cause the record to be skipped the first time they are validated during bulk
processing. Users are able to correct the error when editing the e-invoice in the inbound
EDI/XML work queue.

ﬂ The purchase order invoice mask must be configured to allow free form items.
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» Invoice total

* Entry of tax and freight account codes in the header based in invoice settings.
* UDEF (Userltem 1-5) fields on the header level can contain account codes.

» These are not validated at the time of bulk processing. They are validated only if the e-invoice
has other errors, is placed in the EDI/XML work queue, and the user reprocesses the e-invoice.

» The standard UDEF validation processing remains the same in the invoice workflow and is
performed there if the e-invoice has no errors.

+ Ifthere is a PO number mismatch error, users are redirected to the Reset Page to select a
purchase order for the invoice.

» Validations are performed on e-invoices every time the user processes e-invoices from the
inbound or pre-process work queues (as long as the invoice remains as a temporary invoice).

»  Account code validations (except invoice settings Require Tax Account code to Be Entered
and Require Use Tax Account Code to Be Entered) are not performed during the bulk
processing. They are however performed if the user processes the invoice out of the inbound
and pre-process work queues from the UL

» Ifaccount code validations related to UDEF fields, System setting 828 (Accounting Code:
Enable Verification) need to be performed on e-invoices, then it is recommended to have a pre-
process work queue enabled. If this work queue is not enabled and there are no other errors on
the e-invoices, they are routed through the regular invoice workflow without triggering account
code validations.

To validate an e-invoice:

|E| : {} - . -
1. From the Dashboard, navigate to > Invoice > E-invoice Manager.
2. Use the filter options to find the desired invoice, then select it from the list.

3.  Click Validate Invoice.

A success message is displayed. If the e-invoice has no errors, it is ready to be processed. If the e-invoice
has an error, it is sent to the inbound work queue in the Invoice Task Center.

8.2.2 Processing an E-Invoice

If the e-invoice is selected and has an error, the invoice date and error are shown below the Filter field. e-
invoices that have errors cannot be processed. For e-invoices to be processed successfully, the item
number/SKU on the Edit Item needs to be in the vendor item number field on the Edit Item Step 2 page.

To process an e-invoice:

L[:=]]
E 1. From the Dashboard, navigate to a ” > Invoice > E-invoice Manager.

2. Use the filter options to find the desired invoices, then select the invoices that are ready to

be processed.

3. Click Process Invoice.

A success message is displayed in the processing feedback section and the e-invoice is placed in the
appropriate status and work queue in the Invoice Manager module.
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8.2.3 Viewing an E-Invoice

For non-PO e-invoices, the non-PO invoice mask has to be configured to have a location ID set up in the
Default Value column for the Location ID field. If there is not a location ID in the Default Value column
for the Location ID field, the non-PO e-invoice has a location ID of 0. This means that the non-PO

invoice cannot be viewed or sent for approval.

2016-5467267

User Name

Invoice Number :

Details

Item 1 eIt.em
o s 1 2 3

o

0

Vendor Name :

Account Code :

Contact1:

Payment Term :

Default Invoice Type :

Status :

Payment Term :

Payment Type :

Date Created :

Created By :

Unknown

Net 30

Default

2016-5467267

in processing

Credit Card

05/17/2016

Line Udef Line Udef Line Udef Expensed

Amount

Address 1:
City/State/Zip : Charlotte, NC 28269
Contact2:
Payment Type : Credit Card
Notes
Invoice Date : 05/17/2016
Date Created 05/17/2016
Freight : 0.00
Tax: 52.50
Invoice Total:  927.50
Notes :
Item Period Item Committed unit Held Available Invoice Unit
Name Category Amount Amount Amount Cost
Item
5.0 10.00
Desc.
Item
1.0 100.00
Desc.
Item
1.0 100.00
Desc.

Insert a message here for the screen foorter.

Copyright © 2017 Basware, Inc. All rights reserved.

Name bt Status

Cost
50.00

100.00

100.00

Figure 33: View Invoice page

To view an e-invoice:

—_

vk wn

Click View.

If available, click the Image link to view an image of the invoice.

Click the browser’s back icon to return to the e-invoice Manager page.

From the Dashboard, navigate to ﬁ. " > Invoice > E-invoice Manager.

Use the filter options to find the desired invoice, then select the invoice to be viewed.
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8.2.4 Uploading an E-Invoice

E-Invoices that are ready to be brought into the system can be uploaded one at a time through the user
interface.

E-invoice Upload Wizard - Step 1
Source * EDI/XML

Clear Entries

Figure 34: E-Invoice Upload Wizard — Step 1

E-invoice Upload Wizard - Step 2

Vendor * None

XML File No file selected.
Clear Entries

=1

Figure 35: E-Invoice Upload Wizard — Step 2

To upload an e-invoice:

1. From the Dashboard, navigate to {} " > Invoice > E-invoice Manager.
2. Click Upload Invoice.
3. Select the upload source from the Source field.
4. Click Next >>.
5

Select the vendor from the Vendor drop-down field.

ﬂ Only vendors with vendor attributes are displayed in this list.

6. Click Browse to browse for the file to upload and click Open.

7. Click Next >> to finish the invoice upload.

8.2.5 Downloading an E-Invoice

Electronic invoices can be downloaded from the system.

To download an E-invoice:

1. From the Dashboard, navigate to ﬁ. " > Invoice > E-invoice Manager.
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2. Use the filter options to find the desired invoice, then select the invoice to be downloaded.

3. Click Download Invoice.

A confirmation window opens.
4. Enter the appropriate information.
5. Click OK.

The e-invoice file is opened or saved.

8.3 E-Invoice Process Validations

When e-invoices fail validation and cannot be processed, the system moves the failed e-invoices to an
inbound work queue for the appropriate source and proceeds with processing the rest of the invoices in
the batch.

The status of the failed e-invoices is needs review. This status prevents the system from re-processing the
failed e-invoices until they are manually corrected. Once the e-invoices are corrected, they must be

processed manually through the Invoice Manager module.

When e-invoices are edited, the system archives the original invoice using the system’s archival

capabilities.

Users are able to reject failed e-invoices in the inbound work queue. Before the e-invoice is rejected, the
user enters a reason for rejecting the e-invoice. The system sends an e-mail to the vendor with the reason

for the rejection.

The following validations are performed during processing.

8.3.1 Valid Purchase Order Number

The system validates the purchase order number in the c XML document with the purchase orders in the

system.

» If a valid purchase order number is not found and the e-invoice is in the inbound work queue,
the invoice image rendered based on the XML document has “Invalid PO Number” displayed
in red next to the purchase order number.

» After the user resets the purchase order, the correct purchase order can be associated with the
e-invoice. The user is able to search for the correct purchase order. It is important that the user
makes a note of the correct purchase order number before resetting.

*  When the correct purchase order is assigned to the invoice, the Details tab on the invoice is
refreshed with the line items from the correct purchase order.

* The rendered e-invoice image does not change. This makes it easier for the user to update the

e-invoice line items in the Details tab.
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8.3.2 Valid Purchase Order Item

* The system matches the PO line number in the file with PO line number in the system. If a
valid match is found, the system skips the rest of the validation.

» Ifa match is not found, the system treats all unmatched line items as free form line items.
Users who have permission 3502 - Manage Invoices have the ability to edit the free form line

items in the inbound work queue.

8.3.3 Other Validations

» The system identifies duplicate e-invoices based on invoice number and vendor ID.

» Users who have permission 3502 — Manage Invoices have the ability to open the e-invoice that
failed as a duplicate e-invoice to change the invoice number and resubmit it.

» The system validates invoice total with line items plus tax and freight.

» Users who have permission 3502 — Manage Invoices have the ability to open the e-invoice that
failed due to an imbalanced invoice and change the invoice amount, freight, and tax on the
invoice header to balance the invoice total.

» The system validates the entry of header tax account codes if tax account codes are required
when invoice setting Require Tax Account Code to be Entered is enabled.

» Users who have permission 3502 — Manage Invoices have the ability to open the e-invoice that
failed validation due to missing header tax account code to enter the header tax account code
and process the e-invoice.

» The system validates the entry of header freight account codes if freight account codes are
required when invoice setting Require Freight Account Code to be Entered is enabled.

» Users who have permission 3502 — Manage Invoices have the ability to open the e-invoice that
failed validation due to missing header tax account code to enter the header tax account code

and process the e-invoice.

8.3.4 User Validations

» The system supports the ability to associate a user to a vendor using vendor attributes.

» For incoming e-invoices, the system looks up the e-invoice user attribute associated with the
vendor. If a user is found, the system assigns the user as the invoice creator.

» Ifno users are associated with the vendor, the system skips the validation related to the invoice
creator.

*  When non-PO invoices are submitted as e-invoices, the system defaults the accounting
information based on the vendor/account code template. If a default is not found, the system

sends the non-PO e-invoice to an inbound work queue for user action.
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8.4 Correcting a Failed E-Invoice

E-invoices that fail validation can be corrected in the Inbound EDI/XML Work Queue so they can be sent
through the regular invoice workflow.

The system considers unmatched PO lines as free form items. Failed PO lines are highlighted in red when
in the Inbound and Pre-Process Queues. Passed PO lines are highlighted in green when in the Inbound
and Pre-Process Queues. To correct this, the user can take one of the following actions:

* Allow the failed line to be processed as a free form item.
» Update the failed line to match the PO line.
* Reject the invoice.

To update a failed line to match the PO line, the user needs to manually correct the invoice line so that the
information on the e-invoice matches the PO line. If the failed e-invoice line is marked as a free form
item, the system does not attempt to match it when Process is clicked. If the unmatched line item is not
marked as a free form item and there is still an error with the unmatched line, an error message is
displayed.

Invoice masks used for e-invoices must be configured to allow free form.

To correct a failed e-invoice:

'E' 1. From the Dashboard, navigate to Invoicing > Invoice Manager > Invoice Dashboard.
2. Click the EDI/XML link in the inbound work queue.

The e-invoices in the inbound work queue are listed in the grid below.

3. Click the red magnifying account glass icon in the Action column for the e-invoice to
be edited.

4. The system-generated invoice image shows the error that caused the e-invoice to fail in

red. Correct this error on the Edit Invoice page.

5. Click Process once the error is corrected.

The e-invoice is sent to the invoice workflow and is removed from the e-invoice Management List.

8.5 Resetting a PO e-invoice from the Inbound Work Queue
To reset a PO e-invoice from the Inbound Work Queue:

'E' 1. From the Dashboard, navigate to Invoeicing > Invoice Manager > Invoice Dashboard.
2. Click the EDI/XML link in the inbound work queue.

The e-invoices in the inbound work queue are listed in the grid below.

3. Click the red magnifying account glass icon in the Action column for the e-invoice to

be reset.

4. The system-generated invoice image shows the error that caused the e-invoice to fail in
red.

5. Ifthe error is a mismatched purchase order, the user needs to click View PO to determine

view the purchase order that is associated with the e-invoice.
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The associated purchase order is displayed in to the right of the invoice.

Click Reset to disassociate the purchase order with the invoice.
In the Reset Invoice Reason window, enter a reason for resetting the invoice.
Filter for the correct purchase order.

Click Search.

o »® =2

10. Click Notepad “._| to view the purchase order.

11. Click Pencil " to associate the purchase with the invoice.

When the purchase order is associated with the invoice, the invoice line details under the
Details tab are updated to match the purchase order lines. However, the system-generated

invoice image remains the same.
12. Complete the remaining edits.

13. Click Process once the error is corrected.

The e-invoice is sent to the invoice workflow and is removed from the e-invoice Management List.

8.6 Max Wait Days for E-Invoices

When invoice setting Max Wait Days for E-Invoices is enabled, e-invoices that are in in entry status are
canceled on the indicated number of days from the invoice creation date. The system looks at the number
of calendar days from the date the invoice was created to cancel an e-invoice. This check is performed
daily by a scheduled task. When the e-invoice is cancelled, an e-mail is sent to the e-invoice manager
(users with permission 3575 — Manage e-invoices).

Example

If the Max Wait Days for e-invoices is set to 10 days and the e-invoice is created on August 30, the e-

invoice is automatically cancelled on September 9 if no action has been taken.
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9 AP Export for Batched Invoices

The AP Export functionality automatically flattens (denormalizes) data for invoices in “Ready for
Payment” status, preparing the data for export to an external Accounts Payable system or wherever the

tenant wants to use the data.

The tenant must have system setting 932 - Enable Automated AP Data Extracts enabled for AP Export
functionality.

The data is flattened every 30 minutes via a scheduled task. It can be downloaded either to an Excel
spreadsheet from the desktop application, or via API call into a data structure. Contact Basware support to

learn more about the API functionality of AP Exports.
The following are required to access batch invoice data.

» System setting 932 - Enable Automated AP Data Extracts
*  Permission 180 - Manage AP Export Batches

9.1 Invoice Statuses

Invoice Statuses

All invoices that are in “Ready for Payment” status are flattened and included in a batch during the
scheduled task. The invoice remains in “Ready for Payment” status until the batch data has been
downloaded via the API. After the data is downloaded, the invoice status automatically changes to “In
Payment.”

Downloading the batch data to an Excel spreadsheet does not change the invoice status. The
Last Download field on the AP Export Data Management grid does not show any instances in
which the batch is downloaded to Excel.

If an invoice is voided after being added to the batch, but before the batch is marked as downloaded/
exported, the invoice is removed from the batch. If all invoices in a batch are voided before the batch is
marked as downloaded/exported, the entire batch is removed from the system.

If an invoice is voided after the batch has been downloaded/exported, the record is not removed from the
batch. Locking in the invoice ensures the batch in the system reflects the invoice data at the type it was
exported to the payment system.
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9.2 Viewing and Managing AP Export Data
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Figure 36: Manage Invoice Batches page

To view and manage batched AP Export Data:

a.

2.

Navigate to {} " > Invoice > Invoice Batch Manager.

To view the data included in the batch, click the hyperlinked Batch ID for the batch to

View.

To export the data into an Excel spreadsheet, return to the Manage Invoice Batches

management grid and select the batch to export.

4.  Click the E action in the top right.

A dialog box opens, prompting the user to select a location in which to save the Excel file.

which the batch is downloaded to Excel.

Downloading the batch data to an Excel spreadsheet does not change the invoice status. The
Last Download field on the AP Export Data Management grid does not show any instances in
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10 Appendix A: Troubleshooting

10.1 Question 1 - Invoice not Exported from Invoice Manager

An invoice entered was not exported in the AP output file.

Cause
If an invoice does not export, one of the following causes may apply:

» The date the invoice was entered is outside the date range specified in the export process.

» The invoice has triggered a discrepancy and is currently in review. This would be indicated by
reviewing the status of the invoice on the Invoice page.

» The invoice may be fully processed (temporary, open, or rejected). A temporary or rejected
invoice is indicated by reviewing the status of the invoice on the Invoice page.

» The invoice may be a duplicate (same invoice number for the same vendor).

Solution

» Change the export date range of the AP output process to include the invoice date or delete and
re-enter the invoice so that it is captured by the current AP output process.

» Ifthe invoice is in review, complete the invoice review process.
» Ifthe invoice is in entry status, delete and re-enter the invoice or continue reconciliation with

the associated PO or WO.

+ Ifthe invoice is in rejected status, view invoice to identify the rejection cause and resolve
accordingly.

» If the invoice is an open invoice against a PO, verify the lines on the purchase order have been
received.

» Using Report Manager, identify the PO/WO that the invoice has been reconciled against and
resolve the duplication with vendor.
* Click Mark for Export button in Procurement tab/Invoice section.

10.2 Question 2 - Invoice not Showing on PO

An invoice is not showing up against a purchase order that it was entered against.

Summary

An invoice may be deleted or reconciled against another purchase order. This may a duplicate billing
attempt.

Cause

The invoice may be deleted or the same invoice number has been reconciled against another purchase
order.

Solution

» Search for the invoice in Procurement tab > Invoices
» Ifthe invoice has been deleted, the invoice for the purchase order can be re-entered.
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» Ifthe invoice is visible, check against which purchase order is this invoice registered.

10.3 Question 3 - Catalog Price not Updated on Reconciliation

I have tried to update the catalog price by checking the radio button on the reconciliation, but it still does

not update the catalog price with my invoice price when I reconcile invoices. Why is this?

Solution

There is an invoice setting, Update Vendor Pricing During Reconciliation, that controls this behavior. In
addition, if an item is contracted and there is an update on the Edit Contract page, that event allows price
updates if enabled. Either the item should be taken off the contract or the contract should be deleted to
allow price updates on reconciliation.

10.4 Question 4 - Invoices in Discrepancy

Why does an invoice go to discrepancy?

Solution

An invoice goes into discrepancy based on the invoice settings. There are two types of discrepancy. The
first type is receiving discrepancy. This occurs when what is received does not match what is invoiced.
The second type is financial discrepancy. This occurs when the amount on the PO does not match the
amount on the invoice.

10.5 Question 5 - Cannot Reconcile Purchase Order

Why am I unable to reconcile a purchase order?

Solution

* Verify that the correct line items on the purchase order are being entered for the invoice.

* Make sure the item SKUs and names for the items match.

» Verify that the correct receiving/received quantities for the line items are entered for the
invoice.

» Ifthe PO price is different from the invoiced cost, please use the invoiced cost. ~ *If
necessary, contact with the vendor to see why there was a difference in price.

+ If the option to round the invoiced line cost to 2 decimal places from 3 or 4 decimal places is
used, please make the appropriate changes to the invoice total. Otherwise, this causes a PO
discrepancy error.

The same line item cannot be reconciled against two different costs on the same invoice. If you
enter two different amounts against the same line item across multiple invoices, the system
retains the final reconciliation cost. This is the functionality of the system.
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